
 

 

In the workshop – Tip #3 

Tool transition – Making the move 

Summary  
July 2006 
Author: Rob Evans 

Moving to Altium Designer is now easier than ever. Read about smart transition 
tools, improved translators and even retuning your headspace. Embracing the 
philosophy behind Altium Designer’s unified product development system 
opens new design possibilities and allows you to bring more intelligent products 
to market faster than ever before. 

 

Altium Designer and its unified approach to electronic product development represents the future of design – a future 
where device reprogrammability is easily and fully utilized to accelerate the design process and to create more intelligent 
electronic products faster. When you make the move to Altium Designer you can feel confident that you’ve made a 
choice that opens the door to unprecedented design possibilities using a highly-productive unified electronic product 
development solution. 

Because of this, Altium Designer represents the best path forward for users of traditional point tool solutions – both 
competitive products and indeed, earlier versions of Altium’s own products. Altium has invested substantial development 
effort into creating systems and features within Altium Designer 6 that make the task of successfully transitioning from 
other design systems as easy as possible. 

Altium Designer has numerous features and information resources to get you up to speed with the design system and 
have you productive in the shortest possible time. Here are some pointers and hints to help smooth that process. 

Mapping concepts to the tool – the point of it all 

The first and perhaps most important task in a successful design software transition is to approach it with the right 
mindset. A potential barrier to getting the most out of any new system is overcoming your existing ideas about how the 
tool should work. You tend to view things based on the way your previous system behaved, which is perfectly 
understandable, but can create a feeling of frustration when the steps or operations you have always used may not yield 
the same result in a new system. Here, a type of ‘psychological inertia’ can cause you to fight against the tool rather than 
being open to a different approach or way of working. 

In order to use a new system effectively you need to work with the system, not against it. Finding the right keystrokes 
and menu items is a mechanical learning process that will come with use, but understanding the underlying concepts that 
drive the design system is something that you must be open to, and coming to terms with differences in philosophy 
between one design system to another is really the secret to a smooth transition. 

For example, a unique aspect of Altium Designer is that it provides a unified environment for complete electronic product 
development. It brings together hardware, software and programmable hardware design within a single, unified 
application. Because of this Altium Designer’s PCB editor, for instance, includes some features and concepts that do not 
exist within standalone board tools and may seem foreign to you at first. Working against the unified nature of the 
product will limit your productivity with the tool – embracing the design philosophy behind this unification of design 
disciplines will open up new design possibilities and allow you to bring more intelligent products to market faster than 
ever before. 

For engineers of all design disciplines, Altium Designer offers the capabilities for you to move beyond those traditional 
boundaries by working with both hardware and software within the one environment while using your existing skills. 
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You may not be ready to dive in and interactively implement an embedded system in an FPGA linked to a PCB design 
from day one, but acknowledging the fact that the system has been designed to allow you to do this will allow you to 
understand why particular procedures are done in a certain way and speed your learning of the new system. 

The program and the project 

Starting at a fundamental level, an important concept to note is that Altium Designer is a ‘project-centric’ environment. 
You can simply open a discrete PCB or a text file for direct editing in Altium Designer, but working with a project is a far 
more efficient and effective approach.  

In Altium Designer, a project is the set of files, links and settings that collectively produce the desired result, such as a 
board, or perhaps a hex or bit file. Bringing all these design data elements together is the project file itself, which will be a 
*.PrjPcb in the case of a PCB project. The complete PCB project will typically include the project file, the schematics, 
perhaps project libraries, the board, the BOM and the CAM files. 

This is an important concept to appreciate because, unlike a traditional approach where each design application is 
essentially a separate drafting tool with a specialized set of objects and commands, Altium Designer’s unified platform 
interprets the project’s design data as you work, extracting connectivity information while keeping you informed about the 
state of the design. In a similar way to a good word processor, Altium Designer will highlight errors, like a floating input 
pin, as you work. This allows you to correct simple mistakes as they occur, rather than running an error check as a post 
process.  

Altium Designer achieves this by compiling the design, which allows it to maintain a complete connectivity model in 
memory, thereby giving immediate access to the components and their connective relationships. This subtle but powerful 
behavior brings the design to life and opens the door to new capabilities. For example, hold a shortcut and click on a wire, 
and you’ll see that net highlighted throughout the sheet, or use the Navigator and trace a bus through the entire design. 
Alternatively, hold a shortcut and click on a component in the navigator, and it will appear front and center in the 
schematic and on the PCB. These are just a very small sample of what a project-centric compiling design environment 
offers. 

 

Read more about Altium Designer projects and compiling an Altium Designer project. 

The workspace 

Another concept to become comfortable with is Altium Designer’s unified environment and workspace. And the best way 
to do this is to simply open an example project to see how it all works. There are numerous example projects included in 
Altium Designer, which can be found in the \Examples folder in the Altium Designer installation directory – the DXP menu 
has commands to configure the working environment, including each of the editors. 

Hint: Altium Designer automatically compiles a design before it performs any connectivity-dependent actions such as 
interactive design navigation. You can manually compile the project at any time to ensure the connectivity model is 
up-to-date by selecting the appropriate item on the Project menu. 

Hint: You can completely control which conditions generate warnings or errors when you compile a project.With a 
project open select Project > Project Options… from the menus and configure the settings on Error Reporting and 
Connection Matrix tabs. 

http://www.altium.com/files/AltiumDesigner6/LearningGuides/AP0129ProjectEssentials.pdf
http://www.altium.com/files/AltiumDesigner6/LearningGuides/AR0123ConnectivityandMulti-SheetDesign.pdf
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When you open a project in Altium Designer’s workspace, the set of files in the project is displayed in the Projects panel. 
As you open each file it is displayed in a separate Tab, in a similar way to how a multi-tab web browser works. Then 
when you click on a Tab to switch from a schematic sheet to the PCB, the menus and toolbars automatically change to 
suit the different editing environment. 

Altium Designer’s workspace has been specifically designed to allow you to work seamlessly across different design 
editors, supporting the unified nature of the underlying design system. 

 

Read more about the Altium Designer environment 

Design files 

One task you will need to do when you move to a new design environment is import any current design files you are 
working on to the new environment. You will also occasionally need to reference or update legacy design files. Altium 
Designer has simplified this process by consolidating the import process for all externally created files within a single, 
versatile Import Wizard, which can be invoked from the File menu. This Wizard steps you through the process of taking 
your various design files and importing them into an Altium Designer project. 

All electronic computer-aided design (ECAD) tools store the captured data in separate files – one file for each schematic 
or perhaps all schematics in one file, the PCB in another file, and so on.  

As you move through Altium Designer’s Import Wizard, you can use it to import schematic, PCB and library files from a 
variety of other design tools, including OrCAD® and PADS®. 

 

Transferring a design from one environment to another is a complex process of mapping objects and locating those 
objects in the new design space. It is inevitable that there will sometimes be subtle differences that cannot be completely 
resolved during the import process, however when the mapping is not perfect it is recorded in the log file. 

Ideally you will be able to provide the importer with both the schematics and PCB that make up the original design you 
are translating. Once Altium Designer has completed the import process the resulting project will include the translated 
schematics and PCB. 

Read more about moving from Protel 99 SE, OrCAD or P-CAD. 

Hint: Altium Designer’s workspace is completely configurable. All workspace panels can be relocated, docked, moved 
and combined in various ways by simply clicking and dragging the title bar of the panel. All menus and toolbars can 
be modified by right-clicking on a menu or toolbar and selecting Customize… from the popup menu. 

Hint: You can use the Import Wizard to create in one operation a single Altium Designer project that combines design 
files sourced from a combination of OrCAD® schematics and PADS® PCB files. 

Hint: The description in the wizard will show if the chosen import option requires the files to be in ASCII format. 

http://www.altium.com/files/AltiumDesigner6/LearningGuides/GU0112WelcometotheAltiumDesignerEnvironment.pdf
http://www.altium.com/files/AltiumDesigner6/LearningGuides/AR0115MovingtoAltiumDesignerfromProtel99SE.pdf
http://www.altium.com/files/AltiumDesigner6/LearningGuides/AP0132MovingtoAltiumDesignerFromOrCAD.pdf
http://www.altium.com/files/AltiumDesigner6/LearningGuides/AP0130MovingtoAltiumDesignerFromP-CAD.pdf
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Libraries 

Libraries are a crucial part of any design and must be successfully imported into the new environment. Painstakingly built, 
with each component carefully verified, your design libraries are arguably even more important than the individual design 
files. In the short term they’re important because you will need them to be available in the new design environment, 
immediately.  

The components in the libraries often include a range of data other than the symbolic information, such as component 
parameters, datasheet references and company data. If that company data meshes with other company systems, such 
as your stock control or purchasing database, then a successful transition from the legacy tool into Altium Designer 
becomes even more critical. 

In Altium Designer libraries are also imported using the Import Wizard. In general, if a program’s design files are 
supported, then so is its libraries. In terms of library structure, each design software vendor will have their own method of 
defining a library component. Some base it on the symbol, while others use a tabular approach with a table entry 
equating to a component, which in turn references the symbol, PCB footprint, and so on. 

While Altium Designer can seamlessly translate numerous library types, it’s always a good idea to check all imported 
components carefully. You should also first become familiar with the way Altium Designer stores components and library 
information in order to set the most appropriate options in the Import Wizard. 

Altium Designer has two distinct approaches for defining a component. With one approach the symbol is the component 
and references to the footprint, simulation, 3D and signal integrity models are added to it. You can also add as many 
parameters as required, such as component, datasheet and company information. 

The other component definition approach uses an external database as the record of each component. In that record 
there will be references to the Altium Designer symbol and footprint models, as well as other relevant parameters such 
as component, datasheet, and company information. The record could include other non-board design-relevant data, 
where a mapping file determines which fields you want mapped from the database to the placed component. The 
mapping file is installed as a library in Altium Designer, where you then ‘look through’ it directly into the database, 
selecting and placing components. 

 

Read more about Altium Designer components, database libraries and migrating components. 

Integration to your broader company systems 

The very nature of electronic product development means that designs do not exist in isolation. Information flows into the 
design from your company’s systems – typically as part of the components – and then flows out of the tool back into the 
company system as PDFs for the schematics, CAM files for PCB fabrication and assembly, and the Bill of Materials for 
purchasing and production. There are numerous other requirements for specific information as well, such as a fragment 
of the schematic for the handbook, component overlay detail for the assembly drawing, or a special purpose report for 
the in-circuit test setup process.  

To generate output from your design in a format that can flow back into your company systems, Altium Designer has a 
customizable reporting engine that can extract information from either the schematic or PCB and output this in a variety 
of formats. This can be used to generate an Excel format BOM, a specialized pick and place file, or that CSV format in-

Hint: Altium Designer allows you to easily create libraries that are generated from any schematic project or PCB file. 
As an alternative to importing complete library sets, you can use this feature to create project-specific libraries based 
on the components used in your imported designs. 

http://www.altium.com/files/AltiumDesigner6/LearningGuides/AR0104ComponentModelandLibraryConcepts.pdf
http://www.altium.com/files/AltiumDesigner6/LearningGuides/AP0133UsingComponentsDirectlyfromYourCompanyDatabase.PDF
http://www.altium.com/files/AltiumDesigner6/LearningGuides/AP0143DatabaseLibraryMigrationTools.PDF
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circuit test setup report. To help you manage the myriad of reports and output files you need, the setup for these jobs is 
stored in a special OutputJob file. 

Further to this, in Altium Designer both the schematic and the PCB editors support the Windows clipboard for direct copy 
and paste of design data into another Windows application. There is also a built-in intelligent PDF generation tool that 
creates hot-linked PDFs of the schematic and the PCB, complete with bookmarks of each component and net in the 
design – an ideal format for your design review team. 

Read more about generating a Bill of Materials and editing OutputJob files. 

Where to next? 

Making the transition from a familiar design tool to an unfamiliar one is not a trivial process, but it can be a rewarding one. 
To make it successful you need to invest on many levels – not just on the initial financial outlay. You will need to allow 
time for learning, time for transitioning libraries and designs, plus time for adapting it into your broader company 
processes and systems.  

Importantly though, you also need to allow time for your mindset to adjust. Take a fresh approach to how a design tool 
can work, then embrace any differences you might find in Altium Designer, rather than fighting them – the results will be 
rewarding. 

Altium Designer is a comprehensive and powerful design environment that supports almost all aspects of electronic 
design, including embedded software development, FPGA development and PCB design. Approach it one step at a time, 
use the Knowledge Center to guide you on each command or to research a topic, and use the broader resources such 
as the user forum for expert peer help.  

Experiment with each mouse button – click them, hold them down, explore the wheel behaviour. And one last tip to leave 
you with – if all else fails, right-mouse click on your document in the project panel or that object in the workspace, 
because the command you were thinking about is probably right there. 

As you become familiar with Altium Designer and the potential offered by its unified design environment, you’ll quickly 
understand the new design possibilities it opens up to you. This will allow you to confidently move into the future and 
design more intelligent products faster than you ever could before. 

 

http://www.altium.com/files/AltiumDesigner6/LearningGuides/TU0104 Generating a Custom Bill of Materials.pdf
http://www.altium.com/files/AltiumDesigner6/LearningGuides/TR0127OutputJobEditorReference.pdf
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